This page intentionally left blank.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>3</td>
</tr>
<tr>
<td>Forward</td>
<td>1</td>
</tr>
<tr>
<td>Definitions</td>
<td>1</td>
</tr>
<tr>
<td><strong>Executive Summary</strong></td>
<td>3</td>
</tr>
<tr>
<td><strong>What is in the Work Structure and why is it there?</strong></td>
<td>5</td>
</tr>
<tr>
<td>Documentation</td>
<td>5</td>
</tr>
<tr>
<td><strong>Corporate Dataset</strong></td>
<td>5</td>
</tr>
<tr>
<td>Bentely Folder Structure</td>
<td>5</td>
</tr>
<tr>
<td>- cel</td>
<td>5</td>
</tr>
<tr>
<td>- config</td>
<td>5</td>
</tr>
<tr>
<td>- data</td>
<td>5</td>
</tr>
<tr>
<td>- datasets</td>
<td>6</td>
</tr>
<tr>
<td>- dgnlib</td>
<td>6</td>
</tr>
<tr>
<td>- MDLApps</td>
<td>7</td>
</tr>
<tr>
<td>- pltcfg</td>
<td>7</td>
</tr>
<tr>
<td>- seed</td>
<td>7</td>
</tr>
<tr>
<td>- symb</td>
<td>7</td>
</tr>
<tr>
<td>- vba</td>
<td>7</td>
</tr>
<tr>
<td><strong>Autodesk Folder Structure</strong></td>
<td>8</td>
</tr>
<tr>
<td>- Blocks</td>
<td>8</td>
</tr>
<tr>
<td>- data</td>
<td>8</td>
</tr>
<tr>
<td>- LintType</td>
<td>8</td>
</tr>
<tr>
<td>- PlotStyle</td>
<td>8</td>
</tr>
<tr>
<td>- Template</td>
<td>8</td>
</tr>
<tr>
<td><strong>Sheet Set Manager</strong></td>
<td>9</td>
</tr>
<tr>
<td><strong>Project Folders</strong></td>
<td>11</td>
</tr>
<tr>
<td>Cad_BIM (or Designs in the Simple Project folder structure)</td>
<td>11</td>
</tr>
<tr>
<td>Design_Process (or Confidential in the Simple Project folder Structure)</td>
<td>13</td>
</tr>
<tr>
<td>Out (located under Confidential in the Simple Project folder structure)</td>
<td>13</td>
</tr>
<tr>
<td><strong>Recommended Workflows</strong></td>
<td>15</td>
</tr>
<tr>
<td><strong>File Creation</strong></td>
<td>15</td>
</tr>
<tr>
<td><strong>Design Models</strong></td>
<td>15</td>
</tr>
<tr>
<td><strong>Drawing Models</strong></td>
<td>15</td>
</tr>
<tr>
<td><strong>Sheet Models</strong></td>
<td>15</td>
</tr>
<tr>
<td><strong>File Naming</strong></td>
<td>16</td>
</tr>
<tr>
<td><strong>A/E/C Standard Title Block and Border</strong></td>
<td>16</td>
</tr>
<tr>
<td>Sheet Title Block Tags</td>
<td>16</td>
</tr>
<tr>
<td>Title Block Integration</td>
<td>17</td>
</tr>
<tr>
<td>Sheet identifiers</td>
<td>17</td>
</tr>
<tr>
<td><strong>Drawing Area Title Placement</strong></td>
<td>18</td>
</tr>
<tr>
<td><strong>Back References</strong></td>
<td>19</td>
</tr>
<tr>
<td><strong>Detail Notes</strong></td>
<td>19</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>How do I keep the switches on walls when they are placed at their center and annotation scale changes?</td>
<td>48</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>49</td>
</tr>
<tr>
<td>Where do I Find All of the Content That Used to be in the Workspace?</td>
<td>49</td>
</tr>
<tr>
<td>Why are the Horizontal seed files set to survey feet?</td>
<td>49</td>
</tr>
<tr>
<td>What if I am doing work in a state that uses international feet or Metric?</td>
<td>49</td>
</tr>
<tr>
<td>MicroStation Key-in Reference</td>
<td>51</td>
</tr>
<tr>
<td>MicroStation AccuDraw Shortcut Key-Ins</td>
<td>52</td>
</tr>
<tr>
<td>Drawing Sheet Examples</td>
<td>53</td>
</tr>
<tr>
<td>Change Request, Issue Report and Evaluation Form</td>
<td>58</td>
</tr>
<tr>
<td>Folder Structure Software Use Matrix</td>
<td>59</td>
</tr>
</tbody>
</table>
This page intentionally left blank.

Forward

The A/E/C Work Structure is a working environment, configured to assist the designer to efficiently and effectively assemble their drawings and to follow the A/E/C Standards developed by the CAD/BIM Technology Center. Every item in the work structure has been reviewed and corrected for size, shape and symbology to follow the A/E/C Standards. The A/E/C Work Structure is configured to operate along side of the default datasets delivered by the CAD-BIM software vendors. This allows CAD-BIM managers the flexibility to install minor version releases for updates & bug fixes, while providing full functionality for new releases without reconfiguring the A/E/C Work Structure or waiting for a new version to be developed.

It is our hope that you will find this work structure more effective than the previous workspaces. It is our goal to enhance the A/E/C Work Structure in order to make it easier to use, more efficient and effective. Please share your comments with us by filling out and submitting the Change Request, Issue Report and Evaluation Form located on the last page of this document. Comments, Concerns & Recommendations (CCRs) always welcome.

Note:
Updates to the Work Structure will delete and replace the entire Standards folder structure, the entire AEC_WS_001_ProjectTemplate folder structure, and the AEC_WS_001_ProjectTemplate.pcf file. DO NOT modify these items. Changes to these will be lost on a future update.

The Work Structure Committee – Structure Team (WSC-ST)

Definitions

Workspace: A collection of datasets, extensions, folder structures, and files combined to create a consistent common working environment.

Dataset: A predefined collection of data files.

Extension: Data files that extend the capabilities of the dataset beyond what was delivered.

Project: The CAD/BIM/CIM file folder structure that holds the design and support files for a specific drawing set as defined by the Project Template. The Project Template is delivered in the Workspace/Projects folder.

Master Format: A standard for organizing specifications and other written information for commercial and institutional building projects in the U.S. and Canada.

TOC: In the upper right of many pages, you will see TOC. This is a link to the Table of Contents in this document.
This page intentionally left blank.
Executive Summary

The following is a short list of the features included in the Work Structure.

1. The Work Structure is designed around a common theme to supplement the delivered content from software vendors without taking over complete control of it.

2. The dataset uses MasterFormat division numbers, full descriptions and major to minor category groupings.

3. The Line Styles, Cells/Block libraries, and Parts/Families:
   a. Reduces duplications, improves consistency and provides a greater ease of use.
   b. Consistently sized based on increments of 3/32” and are resizable based upon annotation scale.

4. The Work Structure files are organized into three main categories:
   a. The Common dataset contains items required by all software.
   b. The Horizontal dataset contains items required for InRoads.
   c. The Vertical dataset contains items required for AECOsim Building Designer.

5. Annotation Styles are set to 3/32” text height for common text and 3/16” for Titles, in the Arial font, and either Masked or Unmasked.

6. The Levels are a complete list of those found in the A/E/C CAD Standard with settings now reflecting more appropriate field use colors.

7. Tasks and Templates are defined to aid users in the placement of items according to the A/E/C CAD Standards.

8. All content (e.g. Cells, Styles, etc.) has been evaluated and has the Units of Resolution (UOR) consistently set to 304800/Survey Foot. Multiple macros are included to assist users.

9. The Project Folder Structure substantially remains intact from the TS_WS_001 workspace.

10. An Extensions folder is provided for agencies to add localized content to the Work Structure.

Note:
All content follows the workflows as outlined in the A/E/C CAD and Graphics Standards or as defined in the A/E/C Work Structure accompanying documentation. The use of 3D design models referenced to 2d Drawing models, annotated to represent a specific Plan, Profile, Section, or Detail and the 2d Drawing models referenced to a full size sheet models is critical for the automation to work correctly.
What is in the Work Structure and why is it there?

**Documentation**


**Corporate Dataset**

The Corporate Dataset folder, “Workspace\Standards”, contains all of the A/E/C Standards settings files and datasets. This folder shall be considered **READ ONLY**. Any modifications made in this folder will be **DELETED** in future updates.

The Standards folder contains two sub folders for Autodesk and Bentley datasets.

**Bentley Folder Structure**

- **cel**
  
  This folder contains the Cell libraries and Cell Selector files.

**Cell libraries**

The library files are organized by Master Format Division number and the Cell names are based on the Master Format section it would be found in. The Cell descriptions are expanded to give a better indication of what the cell is. The symbol Cells are sized to use an annotation scale based on a multiple of 3/32” (e.g. 2x3/32” high by 4x3/32” wide). Object Cells are sized so they can be scaled to true size objects by utilizing a scale factor. All Cells have been recreated using a Unit of Resolution (UOR) of 304800 per survey foot, the same as all files in the dataset. Some of the Cell libraries are quite large, so it will be beneficial for designers to become familiar with the A/E/C Symbols Guide in the Docs folder. Cell Selector menus will also assist designers in selecting the Cells graphically.

**Cell Selector files**

The Cell Selector menus were created for visual selection of Cells. They either set the Cell as the Active Cell and/or the Active Pattern. Cell Selector menus can be accessed from the AEC pull-down menu (AEC Menu -> Tools -> Cell Selector).

- **config**
  
  This folder contains the configuration files control loading of software.

- **data**
  
  This folder contains the color tables, xml and definitions files.
**Color Tables**

The color tables have been reset to reflect the colors found in Table 3-4 of the A/E/C CAD Standards.

1. AEC_ColorTable3-4_B&W.tbl - For use with IPlot.
2. AEC_ColorTable3-4.tbl - For CAD files

- **datasets**

  **ACAD**
  This folder contains the dataset for supporting MicroStation in DWG work mode.

  **Horiz**
  This folder contains the dataset for supporting Horizontal design software (Civil).

  **Metric**
  This folder contains the dataset for metric mode for both Autodesk and Bentley software.

  **Vert**
  This folder contains the dataset for supporting Vertical design software (Architectural/Structural/MEP).

- **dgnlib**

  **Annotation**
  This folder contains the Text/Dimension and Detail style libraries.

  **DisplayStyles**
  This folder contains the Display Styles library. The 5 Display Styles are named based on the screening values from 20% to 60% in 10% increments.

  **Levels**
  This folder contains all of the A/E/C level libraries.

  Level library features:

  1. All levels as defined by the A/E/C CAD Standards.
  2. Colors are based on RGB values to reflect what is used in the field (i.e. APWA color codes for utilities) and to be more consistent standard for both AutoCAD and MicroStation files.
  3. Contains level filters based on file types.

  **NamedExpressions**
  This folder contains the NamedExpressions library. One of the uses includes parsing the file name to determine what discipline and model file type is used and sets the Tasks menus accordingly.
Tasks
This folder contains the Task libraries. The task menus are set up to help the user select the correct level and set the correct styles for the work they are performing. The task menus have been updated to reflect the changes in the level standards and to guide the user in placing the correct items with the proper file type. Additionally, to reduce the number of mouse clicks a person would have to press to perform common tasks, the general tasks have been placed under all task menus along with the common drafting tools.

1. The Task menus load automatically by design file name.
2. Each Task menu loads General tasks and Drawing tools for easier access to common items.
3. Task Menus can be opened via an A/E/C pull down menu.

- MDLApps
  This folder contains commonly used applications/programs developed using MicroStation Development Language (MDL).

- pltcfg
  This folder contains default plotting configuration files.

- seed
  This folder contains the seed files for new design models and drawing models. The seed files have all been updated to use common Units of Resolution (UOR). Since GeoPAK uses the UOR for its primary setting, and Bentley AECosim Building Designer (ABD) requires a high resolution setting for dynamic views, the setting was changed to 304800/Survey Feet (SF). This setting is extremely close to the previous 1000000/Meter setting. Testing revealed no significant changes to previous files.

The seven (7) seed files provided are:
1. **AEC_DesignSeed_Horizontal.dgn** - Civil, Survey, Landscape, GeoTech ... 3D Model
   Used for the 3d models of surface and sub-surface design.
2. **AEC_DesignSeed_Horizontal_2D.dgn** - Civil, Survey, Landscape, GeoTech ... 2D Model
   Used for the 2d models of surface and sub-surface design (Intended for use with InRoads).
3. **AEC_DrawingSeed_Horizontal.dgn** - Civil, Survey, Landscape, GeoTech ... 2D Model
   Used for referencing the Horz. 3d models, annotation for Sections, Profiles, Plans, and Details.
4. **AEC_DesignSeed_V Vertical.dgn** - Arch, Struc, MEP, ... 3D Model
   Used for the 3d models of surface and sub-surface design.
5. **AEC_DrawingSeed_Vertical.dgn** - Arch, Struc, MEP, ... 2D Model
   Used for referencing the Vert. 3d models, annotation for Sections, Profiles, Plans, and Details.
6. **AEC_Cell_Seed.cel** - Cell library for project, site and or local extensions
7. **AEC_Seed.dgnlib** - DGN library for project, site and or local extensions

- symb
  This folder contains the Line Style resource files.

- vba
  This folder contains the Work Structure Visual Basic program extensions.
Autodesk Folder Structure

- Blocks
  This folder contains ACAD block libraries

- data
  This folder contains the AEC_Open.dws file.

- LintType
  This folder contains the Line Types resource file.

- PlotStyle
  This folder contains the AEC_B&W.stb file.

- Template
  This folder contains the AEC_Horiz and AEC_Vert.dwt files.
Sheet Set Manager

A template file for Sheet Set Manager has been added to the Template project 01_Gen \ Drawings folder. It contains first and second level designators for plot file order and Title Block information is now tied to the Sheet Set with fields. For multiple facilities or volumes copy, rename, and use the new sheet set manager file.
Plotting

Only one PDF print driver is provided (AEC_pdf.pltcfg). This reflects the print CAD to PDF, print PDF to hardcopy printer process. This workflow is used to ensure line weight thickness prints, across all print devices consistently. Hardcopy's where consistency does not matter is the exception. See Plotting

MicroStation

Baseline plot configuration files are delivered to show an example of how to set up plotting.

Note:
It is highly recommended that plot drivers be localized in an Extension to set optional settings in the plot driver and the design script.

ProjectWise InterPlot (Iplot)

Baseline IPlot settings are also included to help set up IPlot.
**Project Folders**

The project folder structure remains mostly unchanged from the TS_WS_001 workspace version. This should allow for a more seamless transition. This section of the documentation will review which items go into each folder to offer a better understanding of how the Work Structure operates.

The simple project folder structure is intended to simplify the folder structure when the complex folder structure is not needed. It also is intended to be the transition to the folder structure that will be similar to what will be used in the upcoming AEC_WS_002 Work Structure. The discipline folders are removed and many of the support folders are redirected to a single folder rather than setting a different folder for each support file type. Models is where each of the BIM/CIM models reside. Ref-Links is where the referenced or linked files reside. Sheets are where the plotted sheet files reside.

**CAD_BIM (or Designs in the Simple Project folder structure)**

CAD_BIM (Designs) is the parent folder that contains the sub folders for the design files. This folder is intended to only contain the CAD/BIM/CIM files that are to be delivered to a contractor at contract award and the supporting files needed to maintain those files.

**_Master_Models (not included in the Simple Project folder structure)**

This folder is intended to contain all of the Revit Central Models or the Bentley Project Master Model (the file that references each of the discipline Master Models into a single file for creating i-models or other complete views of the project).

**_Sheets (or Sheets in the Simple Project folder structure)**

This folder contains all of the CAD files used as plotted sheet files for the project. This folder should only contain the plotted files and not reference files. This allows for automated plotting procedures to plot every file in the folder instead of having to maintain separate lists.

**Cover sheet (located in the _sheets folder)**

In accordance with the A/E/C Graphics Standards, the cover sheet is delivered. This will assist all agencies in using a common standard cover sheet.

**Discipline Folders (or Models in the Simple Project folder structure)**

To help users identify the standard order for plot sets, the discipline folders are numbered in the order the sheet are placed in the Plan set. The folder contains the 3D Design Models from MicroStation, AutoCAD or the BIM/CIM software. The BIM/CIM software files contain attribute data the normal CAD files do not have. These models are then used to create 2D Drawing Models.
**Drawings (or Ref-Links in the Simple Project folder structure)**

The Drawings sub-folder of each discipline folder is used to contain the 2D Drawing Models. 2D Drawing Models are used to create annotative 2D drawing views by referencing the 3D Design Models to create Details, Cross Sections, Plans, Profiles, Elevations and enlarged versions. 2D Drawing Models can also contain typical 2D Details, schedules, photos, renderings, etc.

**Note:**
The project Border is located in the 01_Gen/Drawings (Ref-Links) folder.

**Support (Project Datasets)**

The Support folder contains both a Bentley Project Dataset and an Autodesk Project Dataset. The Project Datasets are used by designers to add content to the project that isn’t added by the software or Work Structure.

**Note:**
Extensions are used to add content by the CAD/BIM Manager to all projects.
Design_Process (or Confidential in the Simple Project folder Structure)
The Design_Process (Confidential) sub-folder structure is intended to be used by the designers to further organize to their needs. This folder contains all of the design related documentation that is NOT intended to go to the Contractor at contract award. The sub folders are organized by discipline and these folders will contain design information such as Design Analyses, Calculations, Cut sheets, etc.

**Note:**
New folder creation under the discipline folders in Design_Process are up to the discretion of the users needing them.

_coordination (Coordination in the Simple Project folder structure)
This is a folder to hold the various reports and reporting files for clash detection.

_Cut sheets (not included in the Simple Project folder structure)
This is a folder to hold the data sheets of the equipment used in design.

_Design-Related Shop Drawings (not included in the Simple Project folder structure)
This is a folder to hold Manufacturer supplied shop drawings used in design.

_Energy (not included in the Simple Project folder structure)
This is a folder to hold energy calculations, support files for energy calculations, and LEED certification data.

_InRoads
This folder structure holds InRoads data files. It is located at the root of Design_Process for multiple disciplines to share these resources. This folder contains AEC_Horiz.xin.

Discipline folders (not included in the Simple Project folder structure)
The discipline folders hold the discipline specific data that is NOT sent to the contractor at contract award.

Out (located under Confidential in the Simple Project folder structure)
The Out folder contains the sub-folders that receive the generated output from the CAD/BIM/CIM processes.

_IFC (not included in the Simple Project folder structure)
This folder receives files generated by the IFC export process.

_MISC (not included in the Simple Project folder structure)
This catch-all folder is for receiving the files generated by processes other than IFC export and plotting.
PLOT (located under Confidential in the Simple Project folder structure)
This folder receives the files generated from the print command. This is intended to be a temporary holding place for files while they are checked, validated and sent to the printer/plotter for hardcopy workflows or moved to the P&S Milestone folders.

P&S Sets (not included in the Simple Project folder structure)
This folder contains each of the Plans and Specification Sets for reviews and submittals. These are the files that are ready for reproduction and/or the Record Sets for the project. The sub-folders should be renamed to reflect the status of the content they contain (60%, 90%, Ready for Advertisement, Contract Award, etc.).

Specifications (not included in the Simple Project folder structure)
This folder contains the Specifications files. For SpecsIntact, this folder will hold the files once they are complete and ready to be removed from the SpecsIntact project structure.
Recommended Workflows

This section describes the recommended method for designers to follow the A/E/C CAD and Graphics Standards using the A/E/C Work Structure.

File Creation

The seed files, for Drawing and Design Model are located in the workspace standards seed folder (see Seed Files for description). Horizontal is used for Horizontal construction (Site) models. Vertical is used for Vertical construction (Building) models. The AEC_sheetSeed Model file is located in project dataset seed folder (/../CAD-BIM/Support/Bentley/Seed). All seed files have been predefined to have the appropriate Units of Resolution, Master Units and Sub Units and have been cleaned of extraneous data. The design team should verify all seed files are appropriate for the Project and ensure the sheet Seed has the appropriate Project border attached and the correct data in the title block before starting any new sheets.

Design Models

Design models are 3D models that can contain the information and geometry of the design. Terrain models, structures, walls, ductwork, piping, etc. are combined in these files to provide a base for creating Views of Plans, Sections, Details and Profiles. The design models are located in the CAD_BIM/(discipline) (Models) folders.

Drawing Models

Drawing models are the 2D representation of specific areas in the design model to create the specific Plan, Section, Detail and/or Profile to be references to the sheet Models. Saved Views and/or Dynamic Views are created from the Design Model and are then referenced to the Drawing model file at full scale using coincident world. Most annotation, dimensions, notes with leaders, etc. should be placed in the Drawing Models utilizing annotation scale. The drawing models are located in the CAD_BIM/(discipline)/Drawings (Design/Ref-Links) folders.

Sheet Models

Sheet models are the plotted view representation of the Design and Drawing Models and are located in the ../CAD_BIM/_sheets (../Designs/Sheets) folder. Sheet models have the Project border referenced to the sheet at full scale using coincident world. The Project border is located in the ../CAD_BIM/01_Gen/Drawings (../Designs/Ref-Links) folder. The same scale used for annotation scale in the Drawing Models is used to reference the Plan, Section, Detail and/or Profile to the sheet. Add titles, north arrows, scales, general notes, legends, schedules, etc. to these files. Place ONLY the files that are to be plotted in the _Sheets (Sheets) folder.
File Naming

Design Model File Naming
The A/E/C CAD Standards does not fully define a BIM/CIM Design model file naming convention at this time. Follow the A/E/C CAD Standards naming convention as closely as possible. The user defined fields should be used to describe the model type.

Sheet & Drawing Model File Naming
For the automation to work correctly, follow the sheet and Drawing model Naming Convention in the A/E/C CAD Standard. The _sheets folder should only include files to be plotted. Drawing Model Files go in the discipline/Drawings folders.

A/E/C Standard Title Block and Border
The Title Block and Borders have been standardized and reconfigured to help with several issues. See the A/E/C Graphics Standards for definitions.

1. The detail grid is made of smaller squares. The standard states, no more than one detail can occupy the same grid block. The grid area on the old border was approximately 6” by 5-1/2”. For example, a detail that was 6-1/8” by 5-3/4” would require four grids, which would be an area of approximately 11 x 12 or 132 square inches. With the smaller grid, six grids are required, which would be an area of 9 x 6 or 54 square inches. This leaves an additional 78 square inches to locate additional Details and still be within the CAD Standards.
2. The title block revision area has been reconfigured to allow for consistency between Revit and Bentley Projects. See the AEC Graphics guide for details.

Sheet Title Block Tags
The sheet seed references the border and contains tag sets the user will need to edit. See the section on title block Integration below.

- Tags in the Title Block have the project data tag set shown in orange and the sheet data tag set shown in green. See A/E/C CAD Standards for full description. To edit, Double Click, any Green text in the title block. The Edit Tags (AEC_SHEET_DATA) dialog will appear, Scroll to the appropriate field, Double click the field and enter the value, fill in any additional fields as necessary and select OK.
  1. In the Management Block, lower right hand side, the two fields in orange are in the project data tag set for the optional titles of the blocks and the two in green are in the sheet data tag set for the values. These fields may be used to record the number of the sheet in the set, or to capture information such as the Signature, File Name, Facility Code, Drawing No., Drawing Code or some other Project/sheet specific information.
  3. The Building ID/Volume optional field allows for multiple buildings or Volumes to be designed with the same folder structure. To allow for file separation in the folder structure it is recommended this value be used in the user-definable project field of the file name.
4. A Status field was added below the lower right corner to reflect what stage the drawings are in. Optional values may include, Feasibility, Reconnaissance, Preliminary Engineering & Design (PED), 35%, 65%, 95%, BCOE, Award, Modifications, Amendments, Engineering During Construction (EDC), ... AS-Built.

5. The Production Data tags shown below, were added to the lower left corner of the border to allow for capturing additional information during plotting. Additionally to allow for the binding of the plan set, the lower left corner of the border and horizontal placement was chosen to place Production Data optional fields. Optional values may include filename and path, date and time of plot, user name, and discipline. These fields by default are modified by the plotting design script or pen table text substitution but could also be used with title block integration and bound to an environment variable.

Title Block Integration

If enabled by the ProjectWise Administrator, many title block fields may use ProjectWise title block integration. The tags are bound to environment variables and when the files are opened the tags are automatically updated.

To the right is an example of a ProjectWise interface form for title block sheet data. On the top part of the form are read only project attributes that are written to the project folder and then pushed to all files in the project structure when opened. On the bottom of the form the individual sheet title block data is shown. Below is an example of title block Integration from the form on the right.

Sheet identifiers
The A/E/C Work Structure contains a Cell library (AEC_TitleBlock.cel) that has the title block data ready to be placed in a sheet. These Cells have tags that can be controlled by ProjectWise title block Integration. When setting up a sheet file from scratch, cells can be used to place the title block information in the Cell library AEC_TitleBlock.cel. See the A/E/C Standards for more information on what information belongs in the title block.
**Drawing Area Title Placement**

The A/E/C Graphics Standards describes how the Drawing Area Titles are to be placed and annotated. The A/E/C Work Structure contains a tool to assist in correctly placing them.

A Visual Basic Application (VBA) was written to automate the placement of the Drawing Area Title. The “Place AEC Drawing Area Title” can be found on the General Task Menu. This tool provides two-point placement and automated text for grid location. Options include:

---

**Note:**
When using the VBA tool for placement of the Drawing Area Title, the standard border with the 3” grid has to be referenced at 0, 0 with a scale of 1. The referenced model name has to be named appropriately. The referenced model has to be scaled according to the standard annotation scale factors and rotated if necessary. If any of those items are not in place, further editing will be necessary. See below for a graphical view of how the Drawing Area Title is placed on the grid.

VBA uses the same Workspace Cells that can be used for manual placement. These Cells contain tags/attributes and are designed to be placed at the grid intersections. The Cells are designed to take in
to account the placement for 2 to 13 grids. These Cells are located in the AEC_Div01 - General Requirements cell library.

To quickly place these Cells open the Project Explorer (File -> Project Explorer) dialog tab, Select Links -> AEC_Common

Under (Cells -> Titles and Scales) Double click a Drawing Area Title cell based on the number of grids use in the Detail, and pick the intersection of the sheet grid, to place the Cell. Double click the text to edit the tags. Select the Plan north, and scale as necessary and place according to the graphical Drawing Area Title view above.

The following convention is an accepted practice and will be incorporated into future revisions of the A/E/C Graphics Standards.

Back References

Best Practice Note: If the drawing area is referenced multiple times (not recommended), the first reference listed relates to the first sheet listed, second relates to the second, etc.

The following convention is an accepted practice and will be incorporated into future revisions of the A/E/C Graphics Standards.

Detail Notes

Best Practice Note: place an extra line feed or two after the notes to move them up.
This page intentionally left blank.
References

All references should be located within the Project CAD_BIM folder structure. Cross References to files in other projects is not acceptable. The recommended workflow for project delivery is to copy the CAD_BIM folder, in its entirety, and send it to the recipient. Therefore, it is important for designers to keep unnecessary files out of the CAD_BIM folder. Designers are responsible for this content and should periodically clean the files of all unnecessary references and verify that all necessary references are located inside the project.

Attachment Settings

Reference file paths

The A/E/C Work Structure has been set to disallow the use of full file paths. When full file paths are used, projects become less portable. It is better to use the MS_RFDIR variable to set the search path for references or use relative paths.

Model, Description & Logical Names

When attaching a reference file, it is the responsibility of the designer to fully define the purpose of the reference attachment. The Model Name of the file attached, reference file Logical Name, which is a requirement of the A/E/C CAD Standard and the Description field should be used as necessary to fully define the purpose of reference attachments. These fields give users a description of the purpose the reference and it also is used for conversions between different software.
Ignore When Live Nesting

When referencing a file, it is important to decide how you want the file to perpetuate itself to others who may be referencing your files. “Ignore When Live Nesting” works in conjunction with “Live Nesting” or “Copy Attachments” in the Reference dialog box. “No Nesting” treats every nested reference as ignored, whether it is set to “Ignore When Live Nesting” or not.

There are two choices:

ON, is when you DON’T want others to see your reference when they turn live nesting on. This is the same as an AutoCAD XREF Overlay.

Example: An Architectural designer, when assembling their model, would reference the structural columns to know where to place the walls, but since they don’t control the columns they turn ON “Ignore When Live Nesting”. Others wanting to reference the walls would not be able to see the columns when Live Nesting is turned on. If they want the columns included, they would have to reference the columns directly.

OFF, is when you DO want other users to see your reference when they turn live nesting on. This is the same as an AutoCAD XREF Attachment.

Example: A designer, when creating a drawing model (to later be referenced to a sheet), would reference the floor plan to be able to dimension and place notes. Since they need the floor plan to show up on the sheet, they would turn OFF “Ignore When Live Nesting”. The floor plan would show up on the sheet as a nested reference.

Note:
It is very important to make sure “Ignore When Live Nesting” is turned ON for every reference that isn’t absolutely needed for the file. ProjectWise will copy out files that are attached and not displayed, so designers should be conscious about what files are referenced and how they are referenced to speed up file opening times. Files outside ProjectWise, will pull more than is needed when using packager to pull files to send to others if “Ignore When Live Nesting” is OFF when it would be better set as ON. Files being converted to DWG will have the Xref setting set to Overlay when the option is set ON and set to Attached when set to OFF (Overlay is the preferred option for most AutoCAD Xrefs).
Raster References

File names shall conform to the model file naming convention in the A/E/C CAD Standard with a model file type of “IG” (e.g. *C-IGXXXX.tif/jpg).

Raster files referenced to sheets or models shall be placed in the respective discipline drawings folder. Images not referenced to the CAD_BIM files shall be place in the Design_Process discipline folder. Folder creation in Design_Process is up to the discretion of the users needing them.

Raster File Types

TIFF:
   The GeoReferenced TIF file format is the preferred option for aerial photographic imagery, maps, and drawings where the image is referenced under line work to add more clarity.

MrSID:
   It is NOT recommended to keep MrSID files directly referenced to the production set. The files are extremely large and difficult to manage in a CAD/BIM/CIM environment. It is recommended that the MrSID image be clipped, resampled, and saved as a GeoReferenced TIF file. The smaller file size will allow the software to open faster, plot more effectively and be converted to DWG file format easily if needed.

JPG:
   The JPG file format is the preferred option for non-aerial photographic imagery used for depicting existing conditions referenced to sheets.

PDF and other raster formats:
   The use of other formats is not recommended. Other raster files and PDF files used as background images shall be renamed as above and can be used as raster references.

Note:
   Although the CAD Standard recommends that PDF files be used as raster references for scanned drawings, the TIFF file format is better suited for converting to a DWG file format.

Binding

Per the A/E/C CAD Standard, binding references (i.e. importing reference files into the file or merging references) is not allowed. Merging references makes future editing extremely difficult and dramatically increases file size. It is better to use due diligence to verify that references are delivered with the parent file.
This page intentionally left blank.
Schedules/Excel Spreadsheet, Sheet Index

In accordance with the A/E/C Graphics Standards, the proper settings in Excel for use on CAD sheets are the following:

**Note:**
Although the text is not exactly 3/32” high, this process approximates the A/E/C Graphics Standards, without overcomplicating the process, to what has been determined to be acceptable.

1. All Text is Arial font.
   a. Main Titles are set to Font Size 19.
   b. Sub Titles and all other text is Font Size 10.

2. To combine cells for Titles:
   a. Highlight all cells to be combined
   b. Right click on them
   c. Select Format cells...
   d. Select the Alignment tab
   e. Turn on Merge cells
3. Center text appropriately

4. Line work around each cell is "All Borders".

5. A "Thick Box Border" surrounds the entire schedule and the sub titles.

To place the schedule in MicroStation.

6. In Excel, highlight the shedule, right click on it, and copy it.

7. In Microstation, pull down Edit and select Paste Special.
8. Pick “Embedded Microsoft Office Excel Worksheet” and Paste

![Paste Special dialog box]

9. Change the Method to “By Size”, Turn on “Transparent Background”, and set the scale to “1”.

![Paste OLE Object dialog box]

10. Select an appropriate location for the schedule.

**Note:**
Updading the schedule may require repeating the process.
Creating a sheet Index in ProjectWise
See AECWS YouTube video Playlist Sheet Index
https://www.youtube.com/playlist?list=PL_dyQNqimJWwQSHqUBKfWMcAtBx2I0-d7

Go to and open with Excel, the AEC_INDEX_TEMPLATE.xlsx located in the project folder

NOTE: The AEC_INDEX_TEMPLATE.xlsx file is delivered in the ..\CAD_BIM\01_Gen\Drawings\ of the template Project folder in WSC_001 Update 4 and can be copied and used on existing projects.

1. In ProjectWise, go to the Sheets folder in the project you are creating an index for.
2. Select view named “Sheet Index” or you may create one with the columns, Sheet ID, Sheet Title 1, Sheet Title 2, Sheet Title 3 and File name. See YouTube video.
3. Highlight the sheet files you wish to create an Index Schedule from (Ctrl A, will select all files)
4. Right-Click, anywhere in the highlighted section, at 1/4 the of the way up from the bottom Select Copy List To > Clipboard Tab Separated
5. Select the InputValues tab at the bottom left,
6. Select the cell A1 highlighted in yellow, Right click and select Paste
7. Remove any rows for files that do not belong in the index
8. Scroll to the bottom and identify how many rows you have
9. In SortedSheets tab, Highlight row 1 A-D
10. Hover your cursor over the dot at the lower right hand of row1 – column D
11. Right press and hold to drag the data box the same number of rows you identified in step 7

NOTE: In column D of the image below, you see “Incorrect Sheet ID” for some of the rows. The AEC_WS_Sheet_INDEXER.xlsx follows Table 2-3. Sheet File Discipline Designators of the A/E/C CAD Standards 6.0 any deviation must be dealt with manually
12. Ensure from cell A1, columns A, B, C and D to the end of the data are still highlighted, Select the Sort & Filter > Custom Sort. A predefined custom sort is displayed, Select My Data has Headers.

In this example, Custom Sort will sort by Column D “Incorrect Sheet ID” 1st then by Column A “SHEET_REF_NO”

NOTE: The header name for Column A may differ depending on the variable used for Sheet ID in your ProjectWise implementation.

13. Select OK
14. Starting from cell A2, highlight all the values in columns A, B, and C to the end of the data,
15. Right press and select Copy
16. Select the Index tab
17. Select the cell A4 highlighted in yellow, Right click and select Paste > Values

NOTE: you must Paste Values or you will not get the sorted data.

18. Insert 2 rows between each Discipline,
19. Go to the bottom of the data and check how many rows you have.

NOTE: An ANSI D-Size sheet, depending on the length of the description, can accommodate approximately 3 to 4, three column groups of 110 rows.

20. Cut the overflow data based on 110 row maximum, Select cell E4 highlighted in yellow, Right-Click and paste Repeat as necessary in cell I4
21. Go to the top of the sheet, Cells A3-C3 are merged to create the Discipline Heading field
22. Select the cell A3-C3, Right-Click > Copy (Ctrl-C) the Discipline Heading field
23. Select first cell on the far left above each discipline, Column A, E or I Right-Click > Paste (Ctrl-C)

NOTE: The Discipline name will change automatically depending on the first character of the next line.

24. Select entire table and change the Highlight color, background to white
25. Add any additional formatting
26. Highlight the entire Index table and Copy (Ctrl-C)

27. Open the Sheet file and paste special, embedded
28. Change to place By Size with Scale = 1
29. Tentative to lower left of titleblock area and hit “o”,
30. Tentative to upper right and hit “/2”, and a data point to center the index on the sheet.
Symbology

Annotation & Drawing Scales

All of the cells, text, dimension, and line styles in the A/E/C Work Structure are designed to work with Annotation & Drawing Scales.

The Drawing Scale dialog is activated from pull down menu (Settings -> Drawing Scale). This menu allows the user to quickly adjust the Annotation scale. It is NOT recommended for users to change the working units. The Annotation scale lock must be enabled to use Annotation scale. Make sure the Auxiliary Coordinate System (ACS) is set to the same settings as the Annotation Scale or turn it off. Changes should only be made if the project workflow dictates.

Delivered Scales include:

<table>
<thead>
<tr>
<th>Name</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Size</td>
<td>1:1</td>
</tr>
<tr>
<td>6&quot;=1'-0&quot;</td>
<td>2:1</td>
</tr>
<tr>
<td>3&quot;=1'-0&quot;</td>
<td>4:1</td>
</tr>
<tr>
<td>1 1/2&quot;=1'-0&quot;</td>
<td>8:1</td>
</tr>
<tr>
<td>1&quot;=1'-0&quot;</td>
<td>12:1</td>
</tr>
<tr>
<td>3/4&quot;=1'-0&quot;</td>
<td>16:1</td>
</tr>
<tr>
<td>1/2&quot;=1'-0&quot;</td>
<td>24:1</td>
</tr>
<tr>
<td>3/8&quot;=1'-0&quot;</td>
<td>32:1</td>
</tr>
<tr>
<td>1/4&quot;=1'-0&quot;</td>
<td>48:1</td>
</tr>
<tr>
<td>3/16&quot;=1'-0&quot;</td>
<td>64:1</td>
</tr>
<tr>
<td>1/8&quot;=1'-0&quot;</td>
<td>96:1</td>
</tr>
<tr>
<td>3/32&quot;=1'-0&quot;</td>
<td>128:1</td>
</tr>
<tr>
<td>1/16&quot;=1'-0&quot;</td>
<td>192:1</td>
</tr>
<tr>
<td>3/64&quot;=1'-0&quot;</td>
<td>265:1</td>
</tr>
<tr>
<td>1&quot;=5'</td>
<td>60:1</td>
</tr>
<tr>
<td>1&quot;=10'</td>
<td>120:1</td>
</tr>
<tr>
<td>1&quot;=15'</td>
<td>180:1</td>
</tr>
<tr>
<td>1&quot;=20'</td>
<td>240:1</td>
</tr>
<tr>
<td>1&quot;=30'</td>
<td>360:1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>1&quot;=40'</td>
<td>480:1</td>
</tr>
<tr>
<td>1&quot;=50'</td>
<td>600:1</td>
</tr>
<tr>
<td>1&quot;=60'</td>
<td>720:1</td>
</tr>
<tr>
<td>1&quot;=80'</td>
<td>960:1</td>
</tr>
<tr>
<td>1&quot;=100'</td>
<td>1200:1</td>
</tr>
<tr>
<td>1&quot;=200'</td>
<td>2400:1</td>
</tr>
<tr>
<td>1&quot;=300'</td>
<td>3600:1</td>
</tr>
<tr>
<td>1&quot;=400'</td>
<td>4800:1</td>
</tr>
<tr>
<td>1&quot;=500'</td>
<td>6000:1</td>
</tr>
<tr>
<td>1&quot;=800'</td>
<td>9600:1</td>
</tr>
<tr>
<td>1&quot;=1000'</td>
<td>12000:1</td>
</tr>
<tr>
<td>1&quot;=2000'</td>
<td>24000:1</td>
</tr>
<tr>
<td>1&quot;=3000'</td>
<td>36000:1</td>
</tr>
<tr>
<td>1&quot;=4000'</td>
<td>48000:1</td>
</tr>
<tr>
<td>1&quot;=5000'</td>
<td>60000:1</td>
</tr>
<tr>
<td>1&quot;=6000'</td>
<td>72000:1</td>
</tr>
<tr>
<td>1&quot;=8000'</td>
<td>96000:1</td>
</tr>
<tr>
<td>1&quot;=10000'</td>
<td>120000:1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:2.5</td>
<td>2.5:1</td>
</tr>
<tr>
<td>1:5</td>
<td>5:1</td>
</tr>
<tr>
<td>1:10</td>
<td>10:1</td>
</tr>
<tr>
<td>1:20</td>
<td>20:1</td>
</tr>
<tr>
<td>1:25</td>
<td>25:1</td>
</tr>
<tr>
<td>1:50</td>
<td>50:1</td>
</tr>
<tr>
<td>1:100</td>
<td>100:1</td>
</tr>
<tr>
<td>1:200</td>
<td>200:1</td>
</tr>
<tr>
<td>1:250</td>
<td>250:1</td>
</tr>
<tr>
<td>1:400</td>
<td>400:1</td>
</tr>
<tr>
<td>1:500</td>
<td>500:1</td>
</tr>
<tr>
<td>1:1000</td>
<td>1000:1</td>
</tr>
<tr>
<td>1:5000</td>
<td>5000:1</td>
</tr>
<tr>
<td>1:10000</td>
<td>10000:1</td>
</tr>
<tr>
<td>1:250000</td>
<td>250000:1</td>
</tr>
</tbody>
</table>
Annotation Styles

The A/E/C Work Structure contains several text styles:

- **AEC_COMN_Text**: Most text is this style. 3/32” Arial font.
- **AEC_COMN_Text_MASK**: Same as above with masking turned on.
- **AEC_COMN_Title**: Used for Titles. 3/16” Arial font.
- **AEC_COMN_Title_MASK**: Same as above with masking turned on.

Additionally, several more HORZ_ styles are added, via the Horizontal dataset, for use with InRoads or GeoPAC to set specific justification. These styles are only loaded with Horizontal tools such as InRoads or GeoPAC and begin with “AEC_HORIZ__...”. The horizontal styles are intended for use by the automatic text placement tools within InRoads, and should not be used for text that is manually placed.

On some drawings, a user may want the text to be masked. To make the process of changing the style easier, a tool has been placed in the Right Press menu to toggle text between the AEC_COMN_Text and the AEC_COMN_Text_MASK text styles.

Right Press, select Toggle Text Mask, left click to select the text, then right click to apply the toggle. Right click again to end the process.

Before: 

![Before Image]

After: 

![After Image]

The A/E/C Work Structure contains several dimension styles:

<table>
<thead>
<tr>
<th>Name</th>
<th>Used for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AEC_MS_Horizontal-Arrow</td>
<td>Arrowhead with 1.23’ style text.</td>
</tr>
<tr>
<td>AEC_MS_Horizontal-Slash</td>
<td>Slash style with 1.23’ style text.</td>
</tr>
<tr>
<td>AEC_MS_Vertical-Arrow</td>
<td>Arrowhead with 1’-2” style text.</td>
</tr>
<tr>
<td>AEC_MS_Vertical-Slash</td>
<td>Slash style with 1’-2” style text.</td>
</tr>
<tr>
<td>AEC_MS_Notes</td>
<td>Notes with leader.</td>
</tr>
<tr>
<td>AEC_MS_Keynotes</td>
<td>Notes with leader and diamond shape.</td>
</tr>
<tr>
<td>AEC_MS_Callouts</td>
<td>Keyed notes with or without a leader and circle shape.</td>
</tr>
</tbody>
</table>
The most common tools are found under the General Tasks:

**Place Text:** Places you on the G-ANNO-TEXT level, set the AEC_COMN_TEXT style current, and starts the place text command.

**Place Note:** Places you on the G-ANNO-TEXT level, set the AEC_COMN_TEXT style current, sets the AEC_MS_Notes dimension style current, and starts the place note command.

**Place KeyNote:** Places you on the G-ANNO-KEYN level, set the AEC_COMN_TEXT style current, sets the AEC_MS_Keynotes dimension style current, and starts the place note command.

**Place Arch Dimension:** Places you on the G-ANNO-DIMS level, sets the AEC_MS_Vertical-Slash dimension style current, and starts the place dimension command.

**Place Civil Dimension:** Places you on the G-ANNO-DIMS level, sets the AEC_MS_Horizontal-Slash dimension style current, and starts the place dimension command.

**Line Styles**

This folder contains the Line Style Resources. The Line Styles have all been completely redefined and renamed. The Line Styles all rescale with annotation scale properly and no longer need an adjustment for UOR as long as the AEC_WS_001 seed files are used (See Seed Files for description). The style names now reflect both the MasterFormat division structure and an expanded description to give a better indication of what it is used for. The Key-in “LC=” can be used to build an on-the-fly line style dialog box to easily locate the Line Style you are looking for. The example on the right is the result of “LC=Water”. For a complete listing of the delivered Line Style see AEC_WS_001_Symbols_Guide.pdf in the AEC_WS_001/Docs folder.

**Line widths**

The A/E/C Work Structure has many items preconfigured to establish the line widths. The plot driver in ..\Standards\pltcfg\ has been set to plot the line widths in Table 3-1 of the A/E/C CAD Standard.
The conversion to and from DWG settings are set to also utilize those line weights.

![Image of table showing line weights]  

**Level colors**

The colors set in the Levels are set to standard RGB field colors used by industry. They should be acceptable for most work. All work should be placed using the bylevel setting. To screen objects in reference files, the Levels bylevel color setting can be changed to one of the screened colors listed in Table 3-3 of the A/E/C CAD Standards. The color tables in the workspace have been set to reflect the screened colors of the A/E/C CAD Standard. The plot drivers and design script files have been set to plot the screened color numbers as screened and all others as black. The bylevel setting allows for easier translations to DWG.
Printing and Plotting

Print Styles
With this release of the workspace we have created a Print Style for each of the 5 different paper sizes (ANSI A,B,D,E and F). Below are the default settings for the Print Styles the only difference between them is the paper size.

Print Area: Sheet
View: 1
Paper: ANSI (varies on sheet border used)
Orientation: Landscape
Units: in
Size and Scale: Maximize
Resymbolization: Design Script (AEC_Screen.dscript)
Color: Grayscale
Rasterized: OFF
Print3D: OFF
Print raster images: ON
Update from Design File: ON
Printer driver: AEC_pdf.pltcfg

Screening and Gray Scale

Screening and Gray Scaling is a process that lets the user de-emphasize plotted graphics. The user achieves this by assigning a predefined Gray Scale colors to the graphics they wishes to be de-emphasize.

By Logical Name (Reference file – whole)

<table>
<thead>
<tr>
<th>Sample Logical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCRN60 Topo – Scrn60</td>
</tr>
<tr>
<td>SCRN50 Topo – Scrn50</td>
</tr>
<tr>
<td>SCRN40 Topo – Scrn40</td>
</tr>
<tr>
<td>SCRN30 Topo – Scrn30</td>
</tr>
<tr>
<td>SCRN20 Topo – Scrn20</td>
</tr>
</tbody>
</table>

By Color (Reference file or Active File)
Use level manager to set by-level color to a gray scale value
Work Structure updates

On occasion, you may be asked by your CAD or ProjectWise Manager to purge the workspace from your local machine. This is due to the release of updates to the workspace and the need to clear old files from each machine so they will not conflict with the updates to the A/E/C Work Structure. To purge the workspace files from your computer:

1. Open ProjectWise and log in to the datasource to be purged. If you are already in ProjectWise, close all open files from ProjectWise.
2. Open the Local Document Organizer.
4. Select all of the files located here. (Ctrl + A will select all)
5. Select Purge Copy. (or right click on the files and select Purge Copy)

The next time a file is opened, the new workspace files will be downloaded to your computer.
**i-models**

i-models are the conglomeration of the 3D objects and the facility data present in BIM models. i-models can be used to share data with others who don’t necessarily have any design experience.

The i-models generated from both Bentley AECOsim Building Designer and Autodesk Revit contains a wealth of information that wouldn’t necessarily be accessible to lay persons without the design software that created it.

Two visualization tools, Bentley Navigator or Bentley View, can view the i-model and allow the user to query the data within. Additionally, Bentley software can reference the i-model as any other model and the data becomes useful to them (e.g. A Civil engineer could reference an i-model created from Revit and use the data and location to to allow to connect the utilities to the building design).

**Creating i-models**

Although the uses for i-models may be varied, the creation process is the same. See the i-modelImporter documentation found in the Extensions folder for the steps on how to create an i-model.

**Quantity Take Off**

The i-modelImporter extension (included in the Extensions folder) contains a tool to help users view/import the i-model data into Microsoft Excel to view the model data in a tabular form. This tool also helps a user quantify the model by reorganizing the data in pivot tables, and allows a user to find objects in the model when the data is less than clear on what an object is. See documentation included with the i-modelImporter for information on how to install and use it.

**Clash Detection**

The primary tool for clash detection with i-models is Bentley Navigator. See documentation with Navigator for that process.
Revit

Setting up Revit to use the Work Structure Content

As of update #3, there is no A/E/C Work Structure content for Revit. Download the latest Revit templates from the CAD/BIM centers web site at [https://cadbim.usace.army.mil](https://cadbim.usace.army.mil).

1. Download the appropriate Revit templates.

2. Store the Revit templates in a common location.
   Note: Do not save the files under Standards, or they will be deleted on the next update to the Work Structure. The Local Extension folder would be a more appropriate location.

3. For new projects, create new central models, from the templates, in the projects .../CAD_BIM/_Master_Models/ folder and name the files appropriately.
Q & A:

Do I Need to Set a User When Opening a File?

No, the user has been deprecated from the workspace process. It is now set to “untitled” by default and does not need to be changed. When you select a project, MicroStation Manager will take you to the CAD_BIM folder of the project and it is assumed you know where to place your files from the documentation above.

What are Tasks?

The Task menus allow you to focus your tools on the work you are doing. If you need to place a domestic cold water piping line, select it from the tool and the Task will place you on the correct level, set you to bylevel symbology and start the place line tool all in one button click.

Every Task menu now has the General Tasks, for placing annotation, and the Drawing Tasks, for typical MicroStation tools. If place line isn’t the tool you need, you can select the main task to set the symbology and then quickly jump to another tool to place something else.

The Task menus are either loaded via an application when you open the file or via the menu pull down (AEC Menu -> Tasks). If your file name is correctly set according to the A/E/C CAD Standards, the Task menu for that file type will automatically load for you. If your file is not named appropriately, you can still load the Task menu from the pull down.

What do I do if I Want to Reuse Content in other Projects?

Legacy Content

Contact your local CAD/BIM/ProjectWise Manager to create an extension in the Work Structure Extension folder to add legacy content i.e., cells, line styles, fonts to be loaded from the central location.

Existing CAD Files

It is highly recommended that any new projects use the new seed files and any previous work be brought up to the latest seed file definition before being used on any new project. To do this:

1. Start with the appropriate new seed file from Workspace/Standards/seed
2. Reference in legacy project data file Coincident World, this will allow MicroStation to take in to consideration any changes in working units.
3. Merge or copy the desired reference file elements in to master.

Spot check coordinate values and distances to ensure successful conversion.
**Why Don’t We Just Manipulate the Standards Folder?**

The Standards folder is developed and maintained by the Workspace Steering Committee. Any changes made to that folder are very likely to be wiped out by the next Work Structure update. Since the frequency of the changes is unpredictable, changing those files locally is discouraged.

**Files**

Where are the seed files?

Sheet Seed: In the Project Dataset - Seed folder.
   - sheet files: ...\CAD_BIM\Support\Bentley\seed\AEC_sheetSeed.dgn

Design Model Seed: In the Standards Seed folder.
   - Civil files: ...\Workspace\Standards\seed\AEC_DesignSeed_Horizontal.dgn
   - Civil files: ...\Workspace\Standards\seed\AEC_DesignSeed_Horizontal_2D.dgn
   - Building files: ...\Workspace\Standards\seed\AEC_DesignSeed_Vertical.dgn

Drawing Model Seed: In the Standards Seed folder.
   - Civil files: ...\Workspace\Standards\seed\AEC_DrawingSeed_Horizontal.dgn
   - Building files: ...\Workspace\Standards\seed\AEC_DrawingSeed_Vertical.dgn

Where is the border?

In the General Drawings folder:

   - ANSI D 34x22 (Typical): ...\CAD_BIM\01_Gen\Drawings\AEC_TitleBlock_ANSI_D.dgn
   - ANSI F 40x28: ...\CAD_BIM\01_Gen\Drawings\AEC_TitleBlock_ANSI_F.dgn
   - ANSI E 44x34: ...\CAD_BIM\01_Gen\Drawings\AEC_TitleBlock_ANSI_E.dgn

Where do I Put the Content I Need to Create?

The Project Dataset is under Support in the CAD_BIM folder of the projects. Users should place new content there.

**Annotation/symbols**

Where is the title block text?

In the Standards Cell folder: ...\Workspace\Standards\Cell\AEC_TitleBlock.cel

The Cells are placed at either the lower left or lower right corner of the title block. Check with your CAD Manager for which items are set to use text substitution when plotting the files.

How do I edit a tag?

To edit these tags outside of ProjectWise double click the text field and edit the appropriate tag in the tag dialog. Inside ProjectWise these fields may be setup to use title block integration where the tag is bound to a ProjectWise environment variable.
How do I find Levels more quickly than looking at the level manager?

Right-mouse-press and hold will bring up a menu with Level, Cell and Line Style search tools all of these tools work very similarly.

1. **Select Level Search**
2. Key-in a word in the search field e.g. **GAS**
3. **Select Search**

The search tool searches in the name and the description of the Level, Cell or Line Style.
Where are the Cells?

Each Cell library is organized by the MasterFormat Division number. Most of the Cell libraries are in the Standards folder.

The Bentley Cell libraries are in the ..\Workspace\Standards\Bentley\cel\n
The AutoCAD Block libraries are in the ..\Standards\Autodesk\ACAD\Blocks\n
How do I find Cells more quickly than looking at the Cell manager?

Right-mouse-press and hold will bring up a menu with Level, Cell and Line Style search tools all of these tools work very similarly.

1. Select **Cell Search**
2. Key-in a word in the search field e.g **GAS**
3. Select **Search**
   The search tool searches in the name and or the description of the Level, Cell or Line Style.
**Cell Selector**

For a visual method of finding and selecting Cells, Cell Selector menus were created. Cell Selector menus are accessed from the AEC pull-down menu (AEC Menu -> Tools -> Cell Selector). The menu either sets the Cell as an Active Cell and/or an Active Pattern.

Additionally in the Documentation folder there is a complete list of all of the Cells and line styles in the libraries: `\Docs\AEC_WS_001_Symbols_Guide.pdf`. This file describes each Cell, line styles, and displays how big it should be in your sheet file. For cells, the first line is the name, the second and/or third lines are the description, and the last line is the scale the Cell is displayed at in that document.

**Note:**

Some Cells are meant to be placed using a scale to set the size. E.g. Doors are in inches, so by placing it at a scale of 36, you will be placing a 36” door. Other Cells, such as a duplex outlet, are meant to be placed using annotation scale, so you will use the models annotation scale to resize the Cell in your drawing models.
How do I find Line Style more quickly than scrolling through Line Style manager?

The Line Styles are organized first by MasterFormat Division number and then alphabetically by description. The descriptions should provide enough information to tell its purpose.

The Bentley Line Style libraries are in the ..\Workspace\Standards\Bentley\symb\& The Autodesk Line Types libraries are in the ..\Standards\Autodesk\ACAD\LineType\&

Like for Levels and Cells, Right-mouse-press and hold will bring up a menu with Level, Cell and Line Style search tools.

1. Select Line Style Search
2. Key-in a word in the search field e.g. GAS
3. Select Search
   
   The search tool searches in the name and or the description of the Level, Cell or Line Style.

How Do I Place Drawing Area Titles?

Select the appropriate Cell for the grid spaces you are using and then snap to the lower left grid intersection lines. Edit the tags as needed. See the Drawing Area Title tool.

How Do I Place Scales?

Select the appropriate Cell for the scale you are using and snap to the end of the right end of the Drawing Area Title line.

How do I Place North Arrows?

North arrows are now made of two parts, Plan North and True North. Place the Plan North Cell and then place the True North Cell at the insertion point of the Plan North Cell. Rotate the True North Cell appropriately. If Plan North and True North are the same direction, you can skip placing the True North Cell.
Why is the KEYIND symbol not 1/4” high per NCS?

The new AEC Key indicator symbol 014200-017 is 9/32” high. We changed the height to allow for two alpha-numeric characters to be placed in the symbol and still be proportional to the 3/32” text height. 1/4” hexagon would only allow for one character.

Why do some of the Cells not match the NCS?

For the A/E/C CAD Standards, every Cell in the NCS was evaluated against industry standards, such as ASRAE, NFPA, etc. Where the NCS was not the same as industry standards, the standard setting body was used to describe the Cell. The NCS will be notified of the errors and it will be up to that body to correct. Every Cell was gone through to insure that it was proportional to text height where appropriate, even if the NCS wasn’t. Every Cell was recreated and not just copied from historical NCS data.


When working in MicroStation DWG work mode, how do I simply set up annotation?

DWG work mode in MicroStation has problems with annotation. The Dimension styles require a specific text style text height and can’t be scaled as you can with AutoCAD DIMSCALE. Therefore the A/E/C Work Structure’s DWG mode has multiple dimension and text styles for each standard scale. Additionally, when you save the file, MicroStation resets the style to a previous state. To make it easier to annotate DWG files in MicroStation, a VBA tool has been added to set the styles appropriately for the scale. To access it, right press in MicroStation, pick DWG Workmode, and the DWG Annotation.

This will load the tool below.

![AEC DWG Annotation Tool](image)

Simply select the scale you are working at, whether you want slash or arrow style, and then the tool you want to use. This will set the drawing to the appropriate style and start the tool. Additionally, this will place blocks at the appropriate scale, when you select the place cell tool. And, to combat the resetting of styles on save problem, the Save Design button will save the file and reset the style back to what your settings are currently set to.
Why are leaders at the top of notes on the right and bottom of notes on the right?

This practice comes from manual drafting where you read the drawing from left to right, either following the leader to read the text or read the text then follow the leader. If the leader goes from the top line, where does the sentence end? We shouldn’t stop in the middle of a sentence to follow the leader. That isn’t a good practice. The only reason we could find to change it, was if the software wasn’t capable, which used to be the case, but isn’t any more.

We have noticed that if a user adds an additional carriage return to the note, MicroStation places the leader at the bottom left, but if they remove the extra carriage return it properly displays.

If you just remove the extra carriage return, the note will fix itself.

How do I keep the switches on walls when they are placed at their center and annotation scale changes?

The electrical cells are similar in placement to the NCS blocks. We agree that switches don't work well when placed at their center. The problem is they need to have a different origin depending on what rotation you place it and which scale it is.

To make it easier, we’ll add a new one. Instead of having multiple switch cells for every different type, we created a single new switch cell 262700-020 – Switch MultiValue, which you can place on the edge of a wall and rotate as needed. To keep the text in the correct position, edit either the rotated or un-rotated tag.
Miscellaneous

Where do I Find All of the Content That Used to be in the Workspace?

The content that isn’t in the Workspace standards folder has been placed back in the vendor’s hands. So, AECOsim datasets are now in the Bentley delivered workspace and InRoads data is in the InRoads delivered workspace.

Why are the Horizontal seed files set to survey feet?

The predominant unit of measure for Civil Works projects in USACE is based on the Survey foot. To eliminate the need for a GeoPAK specific seed file it was decided to use a common unit of resolution set to 304800/survey foot.

What if I am doing work in a state that uses international feet or Metric?

Although the unit of resolution is consistently set to 304800/survey foot, the master units can be changed to international foot or meters if need be. Organizations that consistently do work in Arizona, Michigan, Montana, North Dakota, Oregon and/or South Carolina may want to set up a local dataset that contains copies of the seed files with the master unit changed to international feet and the Work Structure will continue to work. Organizations that do international work may want to set up a local dataset that contains copies of the seed files with the master unit changed to meters and the Work Structure will continue to work. The Line Styles, text styles, dimension styles, and Cells are all set to operate with annotation scale and will scale appropriately.

The only problems that will be found are if you use GeoPAK and need to change the units of resolution for the software to operate properly. In that situation, copy the seed files and set the units of resolution to 304800/foot or 1000000/meter.
This page intentionally left blank.
### MicroStation Key-in Reference

#### Angle
AA= Sets the active angle

#### Auxiliary Coordinate Systems
AD = Places relative data points
AX = Places absolute data points PX= Deletes an ACS
RX = Attaches an ACS
SX = Saves the current ACS

#### Cells
AC = Sets the Active Cell and activates the Place Cell tool
AP = Sets the active pattern cell
AR = Sets the Active Cell, and activates Place Cell Relative
CC = Create Cell from fence or selection set
CD = Delete Cell from attached cell library
CM = Creates an array of cells
CR = Rename a cell in the attached cell library
LT = Sets the active line terminator cell
PT = Sets the active point used with the Place Point command.
RC = Attaches a cell library

#### Color
CT = Attaches a color table

#### Dimensioning
LD = Sets the level for dimension data
TV = Sets the dimensioning tolerance limits

#### Element Symbology
CO= Sets the active color
LC = Sets the active line style
WT = Sets the active line weight

#### Files
EL = Creates an element list file
FF = Copy the contents of a fence to a new or existing file
RD = Open another design file
RF = Attach a reference file
SF = Move the contents of a fence to a new or existing file
XD = Exchanges the active file with a reference file

#### Grid
GR = Sets the active grid reference spacing
GU = Sets the distance of the grid dots in working units
UR = Sets the unit round off

#### Line Terminators
LT = Sets the active line terminator cell
TS = Sets the scale factor for the active terminator

#### Levels
LV = Sets the active level

#### OF = Turns levels off
ON = Turns levels on

#### Patterns
AP = Sets the active pattern cell
PA = Sets the pattern angle for pattern cells
PD = Sets the spacing between patterns
PS = Sets the active pattern scale

#### Precision Input
DI = Places a data point at a given distance and direction
DL = Places a data point at a given X, Y and Z distance along the design axes
DX = Places a data point at a given X, Y and Z distances along the view axes
XY = Places a data point using absolute coordinate

#### Scale
LT = Sets the active line terminator cell

#### Text
DF = Opens the Fonts dialog box
DR = Displays a text file
FT = Sets the active font
LL = Sets the maximum line length for text
LS = Sets the lines spacing for multiple lines of text
NN = Sets the active text node number
TB = Sets the tab spacing when importing text
TH = Sets the text height
TI = Sets the copy and increment value
TW = Sets the Text Width
TX = Sets both the height and width of the text

#### View Control
DV = Deletes a named or saved view
RV = Rotates a view
SV = Save a view
VI = Attaches a saved view
WO = Sets the window origin

#### View Control – 3D
AZ = Sets the active depth - absolute
DD = Changes the display depth - relative
DP = Sets the display depth - absolute
DZ = Sets a new active depth - relative

#### Miscellaneous
KY = Sets the key-point snap divisor
## MicroStation AccuDraw Shortcut Key-Ins

<table>
<thead>
<tr>
<th>ACCUDRAW</th>
<th></th>
<th>ACS</th>
<th></th>
<th>SNAPS</th>
<th></th>
<th>VIEW</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Smart Lock</td>
<td>S</td>
<td>Side Rotation</td>
<td>O</td>
<td>Set Origin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space</td>
<td>Change Mode</td>
<td>B</td>
<td>Base Rotation</td>
<td>P</td>
<td>Point Keyin (single)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HA</td>
<td>AccuDraw on Hold</td>
<td>E</td>
<td>Cycle Rotation</td>
<td>M</td>
<td>Point Keyin (multi)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HS</td>
<td>AccuSnap Toggle</td>
<td>RV</td>
<td>Rotate View</td>
<td>I</td>
<td>Intersect Snap</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HU</td>
<td>AccuSnap Suspend</td>
<td>RX</td>
<td>Rotate about X</td>
<td>N</td>
<td>Nearest Snap</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>Quit AccuDraw</td>
<td>RY</td>
<td>Rotate about Y</td>
<td>C</td>
<td>Center Snap</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RQ</td>
<td>Rotate Quick</td>
<td>RZ</td>
<td>Rotate about Z</td>
<td>K</td>
<td>Snap Divisor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>Lock X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>Lock Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td>Lock Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LZ</td>
<td>Lock Sticky Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Lock Distance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Lock Angle</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LI</td>
<td>Lock Index</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RE</td>
<td>Rotate Element</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>?</td>
<td>Show Shortcuts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>Bump Tool Settings</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GT</td>
<td>Go to Tool Setting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GK</td>
<td>Go to Keyin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GS</td>
<td>Go to Settings</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>V</td>
<td>View Rotation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>Top Rotation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Front Rotation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Change Request, Issue Report and Evaluation Form

Please open the attached form, fill it out, and select the email link at the bottom.
<table>
<thead>
<tr>
<th>Folder</th>
<th>Autodesk</th>
<th>Bentley</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD_BIM</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Master Models</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Sheets</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 01 Gen</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 02 HazMat</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 03_SurvMap</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 04 Geotech</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 05 Civil</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 06_Indscp</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 07_Struct</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 08_Arch</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 09 Int</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 11_FIREProt</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 12_Plumb</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 14_Mech</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 15_Elec</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 16_Telecom</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 17_Resource</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Drawings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 18_Other</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 19_ShopDwggs</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- 20_Ops</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Support</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Autodesk</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>--- Bentley</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Folder</td>
<td>Autodesk</td>
<td>Bentley</td>
<td>Other</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>Design_Process</td>
<td></td>
<td>X X X</td>
<td></td>
</tr>
<tr>
<td>---01 General</td>
<td>X</td>
<td></td>
<td>X X X</td>
</tr>
<tr>
<td>---02 HAZMAT</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---03 SurveyMap</td>
<td>X</td>
<td></td>
<td>X X</td>
</tr>
<tr>
<td>---04 Geotechnical</td>
<td></td>
<td>X</td>
<td>X X</td>
</tr>
<tr>
<td>---05 Civil</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---06 Landscape</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---07 Structural</td>
<td>X</td>
<td></td>
<td>X X</td>
</tr>
<tr>
<td>---08 Architecture</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---09 Interior</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---10 Equipment</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---11 FireProtection</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---12 Plumbing</td>
<td>X</td>
<td></td>
<td>X X</td>
</tr>
<tr>
<td>---14 Mechanical</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---15 Electrical</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---16 Telecommunications</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>--- Coordination</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>--- Cut-Sheets</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>--- Design-Related-Shop-Drawings</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--- Energy</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---gbxml</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---InRoads</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Out</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---IFC</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---MISC</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---PLOT</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P&amp;S-Sets</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---01 Submittal</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---02 Submittal</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---03 Submittal</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---04 Submittal</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>---Solicitation</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Specifications</td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>